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Abstract:  The Contaminant Model for Streams (CMS) was developed for 
studies where data and resources for model application are limited. CMS 
can be relatively easily and quickly applied, yet it is a versatile model that 
can be used for a variety of conditions ranging from short-term spill 
modeling to multi-year simulations of contaminant fate in stream water 
and bottom sediments. CMS was developed to fill a gap in the Adaptive 
Risk Assessment Modeling System (ARAMS). Before the addition of CMS, 
ARAMS did not have a one-dimensional contaminant transport and fate 
model for streams that could simulate interactions between the water 
column and sediment bed.   

CMS was developed such that it can be applied within the ARAMS frame-
work and also can be run as a stand-alone application outside of ARAMS. 
The model can be used to simulate a wide range of conditions from spill 
simulations with time steps in seconds to long-term simulations with time 
steps of about a year. A variable time step is used with user options. It can 
be applied for both organic and inorganic contaminants, and the available 
fate and transport processes include advection and diffusion along the 
stream reach, settling, resuspension, burial, volatilization, decay or 
degradation, and diffusion between the water column and the sediment 
pore water. Suspended solids can be transported or a steady-state concen-
tration may be input. However, the ARAMS version does not currently 
include solids transport. Steady-state, uniform hydraulic conditions are 
assumed within the modeled reach. Time-varying upstream loadings and 
flows can be applied, but flows are updated instantaneously throughout 
the reach, i.e., there is no hydraulic routing feature, thus greatly reducing 
model complexity. 

The model user interface provides an easy-to-use method for quickly set-
ting up the model and examining results. The interface also allows the user 
to select the methods and parameters used for the numerical solutions. 
The solution methods were selected to result in very short computer exe-
cution time for most applications. The model was verified against results 
from two other models developed by ERDC, RECOVERY, and PREWet, 
the latter of which uses an analytical solution method. This report 
describes the model and its verification. 

DISCLAIMER: The contents of this report are not to be used for advertising, publication, or promotional purposes. 
Citation of trade names does not constitute an official endorsement or approval of the use of such commercial products. 
All product names and trademarks cited are the property of their respective owners. The findings of this report are not to 
be construed as an official Department of the Army position unless so designated by other authorized documents. 
 
DESTROY THIS REPORT WHEN NO LONGER NEEDED. DO NOT RETURN IT TO THE ORIGINATOR. 
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Preface 

This report documents a one-dimensional, time-varying contaminant 
transport and fate model for streams, referred to as the Contaminant 
Model for Streams (CMS).  CMS was developed by Scott Fant of SpecPro, 
Inc., and Dr. Mark Dortch of the Water Quality and Contaminant 
Modeling Branch (WQCMB), Environmental Processes and Engineering 
Division (EPED), Environmental Laboratory (EL), U.S. Army Engineer 
Research and Development Center (ERDC). This report was prepared by 
Fant and Dr. Dortch. 

This work was conducted as part of the Hazard/Risk Focus area of the 
U.S. Army Environmental Quality Technology (EQT) Research and 
Development Program. Dr. John Cullinane is the EQT Program Manager. 
This work was conducted under the general supervision of Dr. Barry 
Bunch, Chief, WQCMB, and Dr. Richard E. Price, Chief, EPED. 
Dr. Michael Passmore was Acting Director, EL, and Dr. Elizabeth Fleming, 
was Director, EL. 

COL Richard B. Jenkins was Commander and Executive Director of ERDC. 
Dr. James R. Houston was Director. 
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1 Introduction 
Background 

Although there are many water quality models for streams, there was not a 
versatile, yet easy-to-use, model for contaminant transport and fate in 
streams prior to the development of the Contaminant Model for Streams 
(CMS). Such a model was needed for studies involving health risk assess-
ment, which are often characterized by limited data and time to produce 
results. An easy-to-use, yet flexible, model was needed for predicting 
short- and long-term concentrations of contaminants in the water column 
and bottom sediments. 

The Adaptive Risk Assessment Modeling System (ARAMS) (http://el.erdc.usace 
.army.mil/arams/) was developed for the Army by ERDC and the U.S. Army 
Center for Health Promotion and Preventive Medicine (USACHPPM) to 
provide a reliable platform for conducting human and ecological health 
risk assessment. ARAMS integrates multimedia fate/transport and multi-
pathway exposure and uptake with effects assessment to characterize risk. 
Although many models are available in ARAMS for fate/transport in 
water, there were not any models for predicting fate of contaminants in 
streams with sediment interactions. There are many riverine water quality 
models available that were considered for use in ARAMS, however, none 
of these models met the requirements without introducing excessive 
complexity.  

Objectives 

The overall objective of this study was to develop a flexible, but easy-to-
use, one-dimensional (1-D), numerical contaminant model for streams 
and rivers. Other objectives were:  

• to be able to predict time-varying contaminant concentrations in the 
water column and sediment bed and include the effects of sediment 
processes and interactions; 

• to be able to simulate short-term spill concentrations, as well as long-
term fate;  
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• to provide some degree of freedom over the numerical solution 
settings, but still be easy to set up and run and quickly provide useful 
results; and 

• to provide a user interface to facilitate ease of use for model setup and 
quickly viewing results.  

• The report presents the theoretical basis for the model, the model 
verification results, and a description of model inputs.  
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2 Approach 

The fundamental law utilized in the development of the CMS is 
conservation of mass along the longitudinal axis (flow direction) of a 
surface water body, such as streams and rivers. The stream surface water 
is represented by a 1D (longitudinal) discretization for mass balance, 
where mass concentrations are assumed to be uniform across the width 
and depth of the stream. Constituent mass balance is performed for the 
water column and sediment bed. The bed is treated as a single active layer. 
The bed layer for each longitudinal segment is independent of other 
longitudinal bed segments, i.e., there is no longitudinal transport or 
transfer within the bed. Each bed layer interacts with only the water 
column immediately above the bed segment. Numerical solution schemes 
are used to provide flexibility for simulating variable inputs and a variety 
of processes. 

Governing equations 

There are 3 unknowns: contaminant concentration in the water column 
and in the bed and suspended solids concentration, if the solids transport 
option is chosen. For contaminants, the 2 unknowns require 2 equations, a 
mass balance equation for the water column and for the bed. For 
suspended solids, a mass balance equation for the water column is 
required. Each of these equations is presented along with assumptions and 
supporting equations. 

Water column contaminants 

The dependent, state variable for contaminants in the water column is 
concentration of total chemical mass (dissolved and particulate) on a total 
water volume basis. The governing equation becomes  

 

( )

2

2
w w w v

x dw dw w pw pw w

s dr
pw w b dw w db b

c c c kU D k F c k F c
t x x H

V VVF c c F c F c
H H H

⎛ ⎞∂ ∂ ∂ ⎟⎜+ = − + −⎟⎜ ⎟⎜⎝ ⎠∂ ∂ ∂

− + − −

 (1) 
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where 

 U = mean velocity (L/T) 
 Dx = longitudinal diffusion coefficient (L2/T) 
 kv = volatilization rate of the constituent (L/T) 
 x = downstream distance (L) 
 cb = concentration of the constituent in the sediment bed (M/L3), 

total mass on a total volume basis 
 kdw = decay rate of dissolved constituent in the water column (T–1) 
 kpw = decay rate of particulate constituent in the water column (T–1) 
 Vd = mass transfer rate across the sediment-water interface 

resulting from diffusion of the dissolved constituent (L/T) 
 Vs = suspended solids settling rate (L/T) 
 H = hydraulic depth of the stream (L) 
 Fdb = fraction of the constituent dissolved in the sediment bed pore 

water 
 Fpw = fraction of the constituent dissolved in sediment pore water 

(M/L3) 
 Fdw = fraction of the constituent dissolved in the water column 
 cw = concentration of the constituent in the water column (M/L3), 

total mass on a total volume basis 
 Vr = active sediment layer resuspension rate (L/T). 

Equation 1 assumes reversible, equilibrium partitioning between sediment 
solids and water. In addition to the 1-D assumption, uniform velocity and 
dispersion is assumed along the modeled stream reach. 

The processes included in the water column mass balance for contami-
nants are advection, diffusion, settling of particulate mass, resuspension of 
sediment bed mass, dissolved mass transfer across the sediment–water 
interface, degradation/decay, and volatilization. The mass transfer across 
the sediment-water interface is actually a diffusive flow that is dependent 
upon the concentration gradient of the dissolved mass between the water 
column and the sediment bed. The volatilization rate is multiplied by the 
fraction dissolved in the water column because only this fraction is 
assumed to volatilize. The resuspension velocity is not multiplied by either 
the fraction dissolved or fraction particulate because both phases are 
assumed to be introduced into the water column during resuspension. 
However, settling involves only the particulate fraction that is in the water 
column.  
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The terms for the fraction dissolved and fraction particulate in both the 
water column and sediment bed were derived using the water column and 
sediment bed distribution coefficients for reversible, linear, equilibrium 
partitioning between dissolved and sorbed phases and are shown in 
equations 2–5 below. 

 1
1dw

dw

F
K S

=
+

 (2) 

 
1

dw
pw

dw

K SF
K S

=
+

 (3) 

 1
(1 )db

ds s

F
K

=
+ −φ φ ρ

 (4) 

 (1 )
(1 )

ds s
pb

ds s

KF
K

−=
+ −

φ ρ
φ φ ρ

 (5) 

where 

 Kdw = distribution coefficient for the constituent in the water column 

(L/g) 
 S = solids concentration (M/L3) 

 φ = porosity of bed sediments 
 ρs = dry sediment density (M/L3) 
 Kds = distribution coefficient for the constituent in the sediment bed 

(L/g). 

The last fraction, Fpb, is the fraction of constituent in particulate form on a 
total volume basis in the bed and is used for the bed mass balance 
equation. 

Options are built into the model to either input the volatilization rate or 
calculation of it based upon Henry’s Law and Whitman’s two-film theory 
(Chapra 1997) as modified for the influence of water flow and wind as 
described in Appendix A. Mass transfer rate of dissolved constituents 
across the sediment–water interface is calculated based upon flow condi-
tions, molecular diffusivity, and other factors as described in Appendix B. 
Calculation of Vs and Vr is discussed in the section on suspended solids 
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transport. Other independent variables in Equation 1 are input by the user 
as discussed in Chapter 5. 

The terms in Equation 1 can be grouped to form a simplified version of the 
advection/diffusion/reaction equation: 

 
2

2
w w w

x w
c c cU D kc q
t x x

∂ ∂ ∂=− + − +
∂ ∂ ∂

 (6) 

where 

 d sv
dw dw pw pw

V Vkk k F k F
H H H

⎛ ⎞ ⎛ ⎞⎟ ⎟⎜ ⎜= + + + +⎟ ⎟⎜ ⎜⎟ ⎟⎜ ⎜⎝ ⎠ ⎝ ⎠  (7) 

 dr
b db b

VVq c F c
H H

= + . (8) 

The term k includes all of the loss terms for the constituent in the water 
column that depend on the water column concentration. Since the terms 
for resuspension and mass transfer from the sediment bed do not involve 
the water column concentration, they are grouped together and treated as 
a source term, q.  

Bed contaminants 

The mass balance for total (dissolved and particulate) contaminant mass 
in the sediment bed for each stream segment is stated as 

 

( ) ( )b d
db db pb pb b dw w db b

s br
b pw w b

dc Vk F k F c F c F c
dt h

V VV c F c c
h h h

=− + + −

− + −

 (9) 

where 

 kdb = decay rate of dissolved constituent in bed pore water (T–1) 
 kpb = decay rate of particulate constituent in the bed (T–1) 
 Vb = active sediment layer burial rate (L/T) 
 h = active sediment layer thickness (L). 
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Equation 9 includes the following processes for the bed: decay or degra-
dation, mass transfer of dissolved constituents across the sediment–water 
interface, resuspension to the water column, settling of particulate consti-
tuents from the water column, and burial to lower sediment layers. Longi-
tudinal exchange between adjacent bed segments, such as pore water flow 
or diffusion along the stream flow axis, is assumed to be negligible. 

Suspended solids transport 

If suspended solids in the water column are transported, then they are 
treated similar to a contaminant constituent that does not decay or 
volatilize. The solids are advected and dispersed along the length of the 
stream reach in the same manner as the constituents but do not have all of 
the same loss mechanisms. The only loss mechanism for suspended solids 
in the water column is settling. In the same manner there will be an influx 
of solids to the water column from any sediment resuspension that occurs. 
The suspended solids mass balance in the water column is stated as 

 
2

2
s r

x b
VS S S VU D S S

t x x H H
∂ ∂ ∂+ = − +
∂ ∂ ∂

 (10) 

where Sb is the concentration of solids in the sediment bed (M/L3), which 
is the same as the sediment bulk density, (1 )b s= −ρ φ ρ . The remaining 

variables are the same as those defined previously. 

The CMS can also be run with a steady-state solids concentration. In this 
case, solids will not be modeled in the water column, and the background 
solids concentration will be held constant for the entire simulation period. 
This is the only option currently available in the ARAMS version of CMS. 

The modeled suspended solids include both inorganic and organic solids. 
The approach taken here is generally applicable to both types. However, 
total suspended solids concentration is the state variable of interest since a 
total solids balance is necessary to perform analyses for other water 
quality constituents. 

A single active sediment layer is modeled. The active bed layer is assumed 
to have constant properties, thus, the thickness, volume, porosity, bulk 
density, and solids mass are constant over time (i.e., steady-state) and 
assumed to be uniform over the stream reach. Solids and contaminant 
mass that is buried to deep sediments is assumed to be lost. Performing a 
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steady-state solids balance for the bed layer results in the following 
relationship: 

 s
b r

b

V SV V
S

= −  (11) 

where all variables have been previously defined. With the settling and 
resuspension rates specified, the burial rate, which is required for the bed 
contaminant mass balance (Equation 9), can be determined. Alternatively, 
any two of the three rates in Equation 11 could be specified and the 
unknown rate solved. The relationship of water column and bed solids and 
the three process rates are shown schematically in Figure 1. The three 
process rates of Equation 11 are applied throughout the modeled stream 
reach for the steady-state solids option. 

Figure 1. Sediment bed and water interactions for solids. 

Settling rate can be determined based on particle size from Stokes law. The 
resuspension formula of Ariathurai, MacArthur, and Krone (1977) is used 
to estimate bed surface erosion rate 

 1
c

E P
⎛ ⎞⎟⎜ ⎟= −⎜ ⎟⎜ ⎟⎜⎝ ⎠
τ
τ

 (12) 

Active Sediment Layer

Water Column

Deep Sediments

V
s

V
r

V
b

ρ
bΦ
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where 

 E = rate of surface erosion, g/cm2/sec 
 P =  erosion rate constant, g/cm2/sec 

 τ = bottom shear stress, dynes/cm2 

 τc = critical shear stress, dynes/cm2. 

The bottom shear stress must be larger than the critical shear stress for 
erosion to occur, otherwise, E is 0.0. Values for P and τc must be input by 
the user, and values for P typically range between 1.3E-5 and 4.7E-5. The 
critical shear stress can be determined from flume studies or modeling 
experience. The bottom shear stress can be computed from τ = γHs, where 
γ is the specific weight of water (approximately 1.0 dyne/cm3) and s is the 
water surface slope, which is equal to the stream bed slope for steady, 
uniform flow. Although P and τc are input as constant over time, the rate of 
erosion rate can change with time if the flow depth, H, changes as a result 
of flow changes. 

The resuspension rate, Vr (cm/sec), is computed from Vr = E/ρb, where ρb 
has units of g/cm3 here. It can be seen from Equation 11 that large values 
of Vr can result in negative burial rates, which means the bed is scouring 
rather than depositing. When this occurs, it is assumed that deeper clean 
sediments below the modeled bed layer are entrained into the bed layer 
and mixed with the remaining contaminated sediments. Thus, the bed 
sediment mass remains fixed, but contaminant mass is lost to 
resuspension, and the bed contaminant concentration is diluted. 

The stand-alone version of CMS has the option for computing resuspen-
sion rates based on flow conditions; however, for the ARAMS version 1.3, a 
steady-state solids balance is assumed (i.e., no suspended sediment trans-
port). Thus, two of the three sedimentation rates are specified, and the 
third is solved from Equation 11. Only positive burial rates are allowed for 
the steady-state solids balance. 

Stream system description 

The stream system is a single reach with uniform hydraulic conditions, but 
this may be expanded in a future version to allow multiple reaches with 
different hydraulic conditions for each. For the modeled reach, multiple 
points of interest for output can be defined through user-entered usage 
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locations. A usage location is a point at a given downstream distance from 
the farthest upstream node and may indicate a withdrawal point, a habitat 
for a species of interest, or any point where the constituent concentration 
is of interest. The associated distance must be specified for each usage 
location. The total length of the stream reach that will be modeled is the 
distance to the farthest usage location. A diagram of an example stream 
reach is shown in Figure 2. 

Figure 2. Flows and concentrations entering the reach. The subscript i refers to initial 
background flows and concentrations, m refers to the loading values, and the total  

flow rate and concentration entering the reach are denoted as Q and c. 

Background flow and flux data 

A background flow rate, such as the mean annual flow rate, suspended 
solids concentration, and constituent concentrations can be specified for 
the reach being modeled. Background variables are denoted with subscript 
i in Figure 2. In addition to the constant, steady-state background flow and 
loadings, time-varying flows and loads can also be specified at the 
upstream boundary. These variables have the subscript m in Figure 2. 
Time-varying loading, or flux, data are entered for water, suspended 
solids, and all modeled contaminant constituents. These inputs may be 
specified at any time point after time zero, but values for all variables must 
be specified for time zero, except for suspended solids, which does not 
need to be entered if a steady-state solids balance is selected in the project 
settings. In this case, the background concentration is used as the steady-
state concentration for the entire stream reach. The background and time-
varying loading flows are added together, and a flow weighted balance is 
performed on the time-varying and background concentrations to set the 
upstream boundary flows and concentrations.  

Qc
Q

i
c

i

Q
m
c

m
Usage Locations
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Hydraulic conditions 

The hydraulic conditions are not solved, but are specified. Flow conditions 
are assumed to be steady-state within each loading update interval and 
uniform over the modeled reach. Flows can change for each loading 
update interval as a result of changes in Qm, but flow rate, depth, and flow 
area are assumed to change instantaneously over the entire reach, thus, 
there is no hydraulic or hydrologic routing nor any transient flow features.  

Three options are provided for specifying hydraulic conditions: 

1. specify stream width and depth as constants throughout the reach; 
2. specify stream cross-sectional area and depth as a constant throughout the 

reach; and 
3. calculate the stream cross-sectional area of flow and hydraulic depth as a 

function of flow in the reach. 

The background flow for the stream reach is also specified as a constant. 
The third option, i.e., calculation of cross-sectional area and depth from 
flow, uses the following equations: 

 bA aQ=  (13) 

 dH cA=  (14) 

where A is the cross-sectional area of flow, and a, b, c, and d are functional 
coefficients. With A, U can be calculated from U = Q/A. Most stream 
rating curves are in the form of Q = f (stage). Thus, there may be some 
effort involved in generating the relationships described by Equations 13 
and 14. Cross-section channel geometry can be used to generate a rela-
tionship for A = f (stage) and coupled with the flow-stage relationship 
leads to development of an area-flow relationship (Equation 13). Also, 
stream top width (W) is equal to the derivative of A with respect to stage 
[dA/d (stage)], and H = A/W, thus, a relationship for H as a function of 
area can be developed (Equation 14). It should be noted that computed 
resuspension rates will be constant over time unless the third hydraulic 
specification option above is selected.  
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Boundary conditions 

Dirichlet boundary conditions are used for the upstream boundary, thus 
allowing the user to specify concentrations or loading flux at the upstream 
boundary (Chapra 1997). The upstream boundary also uses a pipe condi-
tion where advective flow is allowed into the first segment, but diffusion is 
not allowed across the boundary so that mass will not move backward out 
of the system. The concentration entering the reach is the concentration 
determined using the flow weighted mass balance as mentioned above. 
The boundary condition at the end of the reach is an open boundary where 
both advection and diffusion are allowed across the boundary. A Neumann 
condition is used to specify the derivative of the concentration at the 
downstream boundary (Chapra 1997). The concentration gradient with 
respect to downstream distance across the boundary at segment N is 
assumed to be zero. Therefore, the downstream boundary concentration 
will be equal to the concentration of the last node, N. These boundary 
conditions are illustrated in Figure 3. 

Figure 3. Boundary condition assumptions for the model reach. 

The user may specify an upstream boundary concentration or flux at any 
time update interval. For time steps where a boundary value is not 
updated, the model will perform a linear interpolation between the 
previous and next boundary update to determine the value that should be 
used for each model time step. A boundary condition must be specified for 
time zero and, if no other concentrations are specified, that value will be 
used as a steady-state condition for every time step. 

Advection
Advection
Diffusion

1 2 3 4 5 NN-1N-2

...............

N-3
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3 Solution Methods 

An implicit, finite difference, numerical solution scheme is used to solve 
the partial differential equations for surface water contaminant and 
suspended sediment concentrations (Equations 6 and 10). A choice 
between two numerical integration schemes is provided to solve the 
ordinary differential equation for sediment bed contaminant mass 
(Equation 9). The details of these solution methods are discussed below. 

Finite difference scheme 

A variation of the Crank—Nicolson (CR) method (Chapra 1997) was 
selected for the implicit, finite difference scheme. The CR scheme is a 
centered in time and centered-in-space approximation. This method is 
second-order accurate and is stable even for large time steps. The CR 
scheme reduces numerical dissipation by approximating the spatial 
derivatives at both the present and future time steps. These estimates are 
then averaged to obtain a spatial estimate that corresponds to the 
midpoint of the time step as illustrated in Figure 4 (Chapra 1997). 

 
Figure 4. Computational molecule or stencil for the Crank–Nicolson method using a centered 
difference approximation for the advective term. The dashed lines are meant to show that the 
spatial derivative estimates at the present (N) and future (N+1) times are averaged to obtain 

the estimate at the intermediate time (N+ ½). 

The time weighting in the modified CR method is performed using a 
coefficient of implicity (θ) as shown below for the transport–reaction 
equation (Equation 6) where a central difference for advection is used: 



ERDC/EL TR-07-1 14 

 

( )

( )
( ) ( )

( )

1 11
1 1 1 1

1 1 1
1 1 1 1

2 2

1

1
2 2

2 2
1

1

n n n nn n
i i i ii i

n n n n n n
i i i i i i

x

n n n
i i

c c c cc c U
t x x

c c c c c c
D

x x

k c c q

+ ++
+ − + −

+ + +
+ − + −

+

⎡ ⎤− −− ⎢ ⎥=− − +⎢ ⎥Δ Δ Δ⎣ ⎦

⎡ ⎤− + − +⎢ ⎥+ − +⎢ ⎥Δ Δ⎢ ⎥⎣ ⎦

⎡ ⎤− − + +⎣ ⎦

θ θ

θ θ

θ θ

 (15) 

where 

 c = surface water concentration for contaminant constituent or 

suspended sediment 
 tΔ  = time step 
 xΔ  = spatial step size (L) 
 n = time level. 

Other variables in Equation 15 were defined for Equations 1, 7, and 8. If 2 
is set to a value of 0.0, the equation becomes fully explicit, and the only 
values included are from the current time step. If a value of 1.0 is used, the 
equation is fully implicit and only values from the future time step are 
included. The CR method is a special case where the coefficient of 
implicity is set to 0.5 to obtain an approximation that is centered in time 
as well as in space. This scheme is implemented such that the user can set 
the value for 2. 

Collecting terms and rearranging where all of the unknown terms (values 
at the future time step) are on the left-hand side, and all of the known 
terms (values at the current time step) are on the right-hand side yields 
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where 

 
( )2

xD t
x
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Δ
λ  (17) 

 
2
U t

x
Δ=
Δ

γ . (18) 

This results in one equation and three unknown values for c at locations 
i-1, i, and i+1. However, by constructing a recursive relation for nodes 1 
through N, a matrix can be set up for N equations with N unknowns as 
shown in Equation 19 below, thus requiring an iterative and simultaneous 
solution. 

 (19) 

where din is the right side of Equation 16. This is defined as follows for the 
internal segments: 
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i i i

n
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d c k t c
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 (20) 

The values of α1, α2, 1
nd , and n

Nd  depend on the numerical solution scheme 

that is used and the previously discussed boundary conditions that are 
imposed at the upstream and downstream boundaries. For the second–
order solution method given above, these values are given as 

 1 1 k t= + + + Δα γθ λθ θ  (21) 
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where  

 cb = concentration at the upstream boundary. 

Equation 19 is an N x N tridiagonal matrix, which has zero values in all 
positions except for the diagonal, sub-diagonal, and super-diagonal. A 
tridiagonal matrix can be easily solved using a form of Gaussian 
elimination commonly referred to in engineering disciplines as the 
“Thomas Algorithm.” 

Upwind differencing for the advection was added as an additional option. 
The coefficient of implicity was used to apply the same time weighting as 
was provided with the central difference scheme discussed above. The 
spatial derivative for advection, however, is not centered, rather only 
information at the current and upstream segment are used as follows: 

 ( )
1 1

1 11
n n n n
i i i ic c c cadvection term U
x x

+ +
− −⎡ ⎤− −= − +⎢ ⎥Δ Δ⎣ ⎦

θ θ . (25) 

The main drawback to using the upwind differencing scheme is that it 
tends to introduce numerical diffusion into the solution, especially at high 
stream velocities or large spatial steps. However, this scheme introduces 
less artificial oscillation for sharp gradients than the central difference 
scheme and was added to the model to allow the user more flexibility and 
choice in solving a wider range of problems. 

Equation 16 must be modified for upwind differencing for advection, 
resulting in Equations 26 and 27 below. 
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where 

 u
tU
x

Δ=
Δ

γ . (27) 

Ordinary differential equation solution 

The option of using the Euler method or the fourth-order Runge–Kutta 
method is provided for solving for the contaminant concentration in the 
sediment bed (i.e., Equation 9). The Euler method is easy to implement, 
but it is only first-order accurate in time, and it is expressed as 

 1n n b
b b

dcc c t
dt

+ = + Δ  (28) 

where the term dcb/dt is Equation 9 evaluated with the  most recent 
updates for cw and with cb taken at time level n. 

The fourth-order Runge–Kutta method uses estimates of the slope at four 
points to calculate an improved average slope for the time interval (Chapra 
1997). The classical fourth-order Runge–Kutta method is given by the 
following equation: 

 ( )1
1 2 3 4

1 2 2
6

n nc c k k k k t+ ⎡ ⎤= + + + + Δ⎢ ⎥
⎢ ⎥⎣ ⎦

 (29) 

where the four slope estimates are defined as 

 ( )1 ,i ik f t c=  (30) 

 2 1
1 1,
2 2i ik f t t c tk

⎛ ⎞⎟⎜= + Δ + Δ ⎟⎜ ⎟⎜⎝ ⎠  (31) 
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 ( )4 3,i ik f t t c tk= +Δ +Δ . (33) 

When applied to the constituent mass balance given in Equation 9, this 
yields the following: 
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The final concentration in the sediment bed at the new time step is then 
determined as 

 ( )1
1 2 3 4

1 2 2
6

n n
b bc c k k k k t+ ⎡ ⎤= + + + + Δ⎢ ⎥

⎢ ⎥⎣ ⎦
 (38) 
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Although the implicit solution for the water column is unconditionally 
stable, the solution for the bed is not and can generate oscillating, unreal-
istic concentrations. An adaptive solution option has been implemented 
for solving the ordinary differential equation for the bed to ensure stable 
results. The adaptive scheme starts with a time step, Δt, that is actually 
one-tenth of the specified time step. This helps to insure that the initial 
calculations will meet the convergence criteria. For each time loop, the 
sediment calculations are first performed using the current time step and a 
value that is twice as large as the current time step. If the values from 
these two calculations for all segments meet the convergence criteria, the 
larger time step will be the new time step and the values from the calcu-
lations using this time step will be used for the current time loop. If the 
convergence criteria are not met, the calculations are performed using the 
current time step and a value that is half as large as the current time step. 
If the convergence criteria are met, the current time step will be 
unchanged. Otherwise, the routine will set the current time step to 0.5Δt 
and continue to iterate, lowering the time step with each iteration, until 
convergence is reached.  
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4 Model Verification 

Because there was no readily available, long-term constituent concentra-
tion data to validate the CMS, the model equations have been verified 
using two existing contaminant models: RECOVERY (Ruiz and Gerald 
2001) and PREWet (Dortch and Gerald 1995). RECOVERY is a numerical, 
time-varying model of water column and bed contaminant mass where the 
water column is a single, fully mixed compartment, and the bed is 
modeled with multiple layers over the depth. PREWet is a 1-D (longitudi-
nal), steady-state model with an analytical solution. RECOVERY assumes 
a steady-state solids balance for the bed, and suspended solids are input 
and constant throughout the water column and over time. Although 
PREWet calculates suspended solids concentration at the end of the reach 
given the concentration entering the reach and assuming a steady-state 
solids balance in the bed, the bed solids flux rates (burial, resuspension, 
deposition) are assumed uniform over the reach, and the unknown flux is 
computed using the entering solids concentration. Thus, the suspended 
solids computations are not really coupled with the contaminant computa-
tions. The steady-state solids balance in the bed of both models requires 
entering two of the three rates of settling, resuspension, and burial and 
solving for the unspecified rate assuming that bed solids mass is constant 
with respect to time. 

One organic and one inorganic constituent were chosen for the model 
verification tests, and two test sets were run. The first test was a long-term, 
steady-state loading simulation run for 200 years, long enough for con-
stituent concentrations in both the water column and sediment bed to 
reach steady-state values. All three models were compared for this test. 
The second test was a time-varying test case with stepped constituent 
influx concentrations over a simulation period of 100 years. The constitu-
ent flux was increased at 25 and 50 years and then decreased at 75 years. 
In this simulation, the constituent concentrations in the sediment bed 
were never allowed to reach steady-state. Only RECOVERY was compared 
to the CMS for this test because PREWet does not allow a variable flux 
input. The input data and the results for each test set are described below. 
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Input data 

Three general types of data are required as input: (1) chemical-specific 
parameters/inputs; (2) system or water body inputs; and (3) sediment bed 
properties. Each of the inputs for these test is described as follows. 

Chemical specific inputs 

The constituents used in the test cases were DDT and Chromium III. Both 
of these constituents are known water contaminants. The data required for 
each constituent to perform the tests with the aforementioned models is 
given below. Assumptions were made regarding some inputs to simplify 
comparisons between the models. Extremely small values were used for 
some input values in place of entering 0.0, such as Henry’s law constant 
for chromium. 

DDT 

• Molecular weight – 354.49 g/g-mole 
• Molecular diffusivity – 4.95E-6 cm2/s 
• Henry’s law constant – 8.3E-6 atm-m3/g-mole 
• Octanol–water partition coefficient (KOW) – 8.128E+6 mL/mL 
• Partition coefficients 

o Water column – 0 L/kg 
o Sediment bed – 0 L/kg 

• Decay rates in water column 
o Dissolved fraction – 0.00388 /day 
o Particulate fraction – 0 /day 

• Decay rates in sediment bed 
o Dissolved fraction – 0.00388 /day 
o Particulate fraction – 0 /day 

• Volatilization rate from the water column – 0.111 m/day (calculated) 
• Mass transfer velocity between water and sediment – 0.00133 m/day 

(calculated) 
• Initial concentration in water column – 0 mg/L 
• Initial concentration in sediment bed – 0 mg/L 

Chromium III 

• Molecular weight – 51.996 g/g-mole 
• Molecular diffusivity – 5.94E-6 cm2/s 
• Henry’s law constant – 9.60E-40 atm-m3/g-mole 
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• Octanol–water partition coefficient (KOW) – 0 mL/mL 
• Partition coefficients 

o Water column – 100,000 L/kg 
o Sediment bed – 1,000,000 L/kg 

• Decay rates in water column 
o Dissolved fraction – 0 /day 
o Particulate fraction – 0 /day 

• Decay rates in sediment bed 
o Dissolved fraction – 0 /day 
o Particulate fraction – 0 /day 

• Volatilization rate from the water column – 0 m/day 
• Mass transfer velocity between water and sediment – 0.00477 m/day 

(calculated) 
• Initial concentration in water column – 0 mg/L 
• Initial concentration in sediment bed – 0 mg/L 

Water body parameters 

Since each of the models being used is intended for different types of water 
bodies, the following general physical characteristics were applied to each 
model as appropriate to simulate the same conditions. 

• Average annual depth of water body – 3 m 
• Average annual width of water body – 50 m 
• Length of water body – 100 km 
• Average annual surface area of water body – 5E6 m2  
• Average annual volume of water body – 1.5E7 m3 
• Average annual flow – 1E9 m3/yr 
• Average annual temperature – 20ºC 
• Incoming suspended solids concentration – 150 mg/L 
• Fraction organic carbon in suspended solids – 0.02 
• Longitudinal dispersion coefficient – 16200 m2/hr (CMS only) 

Sediment bed parameters 

The following parameters were applied to all models for the active 
sediment layer. 

• Average thickness – 10 cm 
• Average porosity – 0.35 
• Average dry sediment density – 2,650 g/L 
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• Fraction organic carbon in sediment bed – 0.02 
• Settling velocity – 0.1 m/day 
• Burial velocity – 4.7E-6 m/day 
• Resuspension velocity – 4.467E-6 m/day (calculated) 

Steady-state test case 

The steady-state test case was run for each model using the information 
given above and a constant constituent influx of 30 mg/L for each con-
stituent. The simulation was run for a period of 200 years allowing the 
water column and sediment bed concentrations for both constituents to 
reach steady-state. Table 1 shows the results from each of the three 
models. The results for CMS and PREWet are reported at the end of the 
modeled reach. 

Table 1. Steady-state test results. 

Model Contaminant Water Conc., mg/L 
Sediment Conc. 
mg/kg 

PREWet DDT 26.97 168600 
 Chromium III 27.34 171400 
RECOVERY DDT 26.6 166000 
 Chromium III 27.4 171000 
CMS1 DDT 27.0 168000 
 Chromium III 27.3 171000 
 Solids 150  
CMS2 DDT 26.8 184000 
 Chromium III 27.2 187000 
 Solids 135  

1  CMS run with steady-state solids balance in water column.   
2  CMS run with suspended solids transport. 

The results from all three models match well for the water column concen-
trations for both constituents. This is true for both the steady-state solids 
balance and with suspended solids transport. However, both the DDT and 
Chromium III sediment concentrations predicted by the CMS with solids 
transport are about 9.5 percent higher than all other predictions. The 
reason for the difference is due to a gradient in the suspended solids 
concentration created along the stream reach, dropping from the inflow 
concentration of 150 mg/L at the upstream boundary to 135 mg/L at the 
end of the reach. The calculated resuspension velocities for each cell also 
decreased along the stream reach, and more constituent mass becomes 
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bound in the bed at the low end of the reach. The RECOVERY and 
PREWet models used a steady solids concentration of 150 mg/L 
throughout.  

A test was next performed using both the RECOVERY and PREWet 
models with the suspended solids concentration of 135 mg/L calculated by 
the CMS for the end of the stream reach. The results from this test are 
shown in Table 2. 

Table 2. Steady-state solutions for RECOVERY and PREWet using modified suspended 
solids concentration of 135 mg/L. 

Model Contaminant 
Water Conc.  
mg/L 

Sediment Conc. 
mg/kg 

PREWet DDT 26.68 184000 
 Chromium III 27.08 187400 
RECOVERY DDT 26.4 181200 
 Chromium III 27.2 186900 

 

As can be seen in Table 2, the sediment concentrations computed by 
RECOVERY and PREWet are about the same as those computed by CMS 
when using the same suspended solids concentration as the CMS. This test 
helped to verify that the CMS is working properly, at least for a steady-
state loading. 

Time-varying test case 

This test case was run for the 
RECOVERY model and the CMS 
using the same data as the steady-
state case above and stepping the 
constituent influx at 25-year 
intervals for each constituent. 
Table 3 shows the inflow concen-
trations for the models. 

Table 3. Constituent inflow concentrations for 
step function test case. 

Time, yr Influx concentration, mg/L 
0 30 
25 40 
50 50 
75 15 
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The simulation was run for a period of 100 years without allowing the 
sediment bed concentrations for either constituent to fully reach steady-
state conditions at any point during the simulation. The inflow concen-
tration after year 75 is assumed to remain at 15 mg/L. Table 4 shows the 
final results for both models at the end of the simulation and at the 
downstream end of the reach. The CMS run was made using the 
suspended solids transport routing option. 

Table 4. Final results for RECOVERY and CMS models for the step function test case. 

Model Contaminant 
Water Conc.  
mg/L 

Sediment Conc. 
mg/kg 

RECOVERY1 DDT 13.36 86,621 
 Chromium III 13.77 89,298 
RECOVERY2 DDT 13.23 95,864 
 Chromium III 13.65 98,915 
CMS DDT 13.4 97,400 
 Chromium III 13.6 99,100 
 Suspended Solids 135  

1  RECOVERY run with suspended solids concentration of 150 mg/L.   
2  RECOVERY run with suspended solids concentration equal to that in the last segment of the 
CMS, 135 mg/L. 

 

The comparison of CMS and RECOVERY results shows that the water 
concentrations are close. The sediment concentrations also agree fairly 
closely when the same suspended solids concentrations are used in the two 
models. The minor differences between the two results could be due to the 
fact that RECOVERY treats the entire reach as a single, fully mixed cell of 
homogeneous concentration, whereas CMS computes a gradient in 
concentration along the reach. This test verified the CMS for time-varying 
input data. 



ERDC/EL TR-07-1 26 

 

5 Model Inputs and User Interface 

A user-friendly interface has been created for entering model input data, 
executing the model, and examining model output. To launch the CMS 
user interface in stand-alone mode, double click the CMS icon on the 
desktop (Figure 5).  

Figure 5. CMS desktop Icon.  

The program can also be launched by clicking on the Windows "Start" 
button and selecting "Programs -> CMS -> CMS." Figure 6 shows all of the 
entries under the "CMS" menu. The first entry, "CMS," will launch the 
graphical program interface. The second entry, "CMS Help," will launch 
the CMS help file. The last entry is used to remove the CMS model from 
the user's computer.  

Figure 6. CMS Start Menu Item.  

When the CMS model is run from within ARAMS/FRAMES, the standard 
menu items are used to launch the model, run the model, and launch the 
results viewer. 

After launching the CMS interface, the main screen will appear as shown 
below in Figure 7.  
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Figure 7. CMS Main Screen. 

When the CMS interface is first launched, the default behavior is to create 
a new data file. However, if at any time the user wishes to start a new 
project, this can be done by selecting "File -> New" from the main menu as 
shown in Figure 8 below.  
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Figure 8. New Data File. 

To open an existing data file, select "File -> Open" from the main menu as 
shown in Figure 9.  

Figure 9. Open Data File. 

The open file dialog will then be shown as in Figure 10. Browse to the 
folder where the desired file is located, select it, and click the button 
labeled "Open" at the bottom of the dialog. The file can also be opened by 
double-clicking the left mouse button on the file from the open file dialog 
or from any Windows Explorer dialog. *Note: an extension of “.st1” is used 
for all CMS data files.  
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Figure 10. Open File Dialog.  

If the data file to be opened was one of the last four files to be opened, it 
will appear in the recent files list on the file menu. The recently used files 
will be numbered consecutively from one to a maximum of four and will 
appear just above the "Exit" option on the file menu as shown in Figures 8 
and 9 above. The most recently used data file will appear at the top of the 
list. Holding the mouse over the file name will cause the full path to the 
data file to be displayed on the status bar at the bottom of the main 
application window as shown in Figure 11. To open one of these files 
simply select the desired item from the menu.  
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Figure 11. Recent Data Files. 

To open a CMS results data file, select "File -> Open" from the main menu 
as was done for opening an input data file. The open file dialog will then be 
shown. The default setting when selecting "Open" from the file menu is to 
open an input data file. To select a results data file, select the "Files of 
type" combo box at the bottom of the dialog, and change the file type to 
"CMS Results (*.ac2)" as shown in Figure 12. 
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Figure 12. Change File Type.  

The files list will now display only CMS results data files (Figure 13). Select 
the desired file and click the button labeled "Open" to load the results file. 
As with input data files, the file may also be opened by double-clicking the 
item in the open file dialog or any Windows Explorer window. *Note: an 
extension of “.ac23” is used for all CMS results data files.  

Figure 13. Open Results Dialog. 

Data entry is performed through the five main screens of the CMS 
interface. To access each of these screens, use the toolbox on the left-hand 
side of the interface as shown in Figure 14.  
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Figure 14. Main Screen Toolbox. 

The model parameters screen consists of entry forms for most of the 
general parameters including time step, spatial step, total simulation time, 
etc. The model parameters screen is shown in Figure 15, and an explana-
tion of the input fields is given below.  
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Figure 15. Model Parameters Screen. 

 

Model Parameter Field Descriptions 

• Segment Length Options - One of the following options must be 
selected. 
o Number of Segments - Specifies the number of segments in the 

stream reach; the segment length will automatically be calculated. 
o Length of Segment - Specifies the length of the segments in the 

stream reach (units may be specified in combo box). The number of 
segments will automatically be calculated. 

• Time Step - Specifies the length of the time step to be used (units may 
be specified in combo box). 
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• Total Simulation Time - Specifies the total length of the simulation 
(units may be specified in combo box). 

• Longitudinal Dispersion Coefficient - Specifies the longitudinal 
dispersion coefficient to be used (units may be specified in combo box). 

• Suspended solids concentration at point of entry - Specifies the 
concentration of suspended solids in the stream at the point of entry 
(units may be specified in combo box). Solids concentration loading 
data will be specified on the Loading Data screen. 

• Depth of Active Sediment Layer - Specifies the depth of the active 
sediment layer (units may be specified in combo box). 

• Dry Sediment Density - Specifies the density of the sediment bed in 
mass per volume dry weight (units may be specified in combo box). 

• Sediment Porosity - Specifies the porosity of the sediment bed. 
• Fraction Organic Carbon in Solids (Water Column) - Specifies 

the fraction of organic carbon present in the suspended solids in the 
water column. 

• Fraction Organic Carbon in Solids (Sediment) - Specifies the 
fraction of organic carbon present in the solids in the sediment bed. 

• Temperature (deg C) - Specifies the temperature in degrees Celsius. 
This is required if the "Calculate" option is specified for the 
volatilization rate or the mass transfer velocity for any constituent. 

• Wind Speed at 10 m above Surface - Specifies the wind speed at 
10 m above the surface of the stream. This is required if the "Calculate" 
option is specified for the volatilization rate for any constituent. 

The hydraulic parameters screen consists of entry forms for hydraulic 
parameters including width, depth, cross-sectional area, etc. The hydraulic 
parameters screen also contains entries for each of the usage locations in 
the stream reach. A usage location is a point at a given downstream 
distance and may indicate a withdrawal point, a habitat for a species of 
interest, or any point where the constituent concentration is of interest. 
The hydraulic parameters screen is shown in Figure 16, and an explanation 
of the input fields is given below.  
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Figure 16. Hydraulic Parameters Screen. 

 

Hydraulic Parameter Field Descriptions 

• Usage Location - Usage locations can be added, edited, or deleted 
using the button to the right of the usage location combo box. Use the 
drop-down button at the right to select the appropriate action from the 
menu as shown in Figure 17, then click on the button to perform the 
action. 
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Figure 17. Usage Location Drop-Down Button.  

• Distance to usage location from point of entry - Specifies the 
downstream distance to the currently selected usage location (units 
may be specified in combo box). 

• Cross-sectional area options - One of the following options must 
be selected. 
o Surface water width and depth 

■ Stream width - Specifies the width of the stream for the 
maximum extent of the reach (units may be specified in combo 
box). 

■ Stream depth - Specifies the depth of the stream for the 
maximum extent of the reach (units may be specified in combo 
box). 

o Cross-sectional area - One of the following options must be 
selected. 
■ Constant value - Specifies a constant cross-sectional area of 

the stream for the maximum extent of the reach (units may be 
specified in combo box). 

■ Function of stream reach flow rate, a(Qs)^b - Qs is the 
stream flow rate including any flows supplied on the loading 
data screen. 
� a - Specifies the first coefficient in this function. 
� b - Specifies the second coefficient in this function. 

When using this method, the stream depth can be related to 
the cross-sectional area by H = cA^d where H is the stream 
depth, A is the cross-sectional area, and c and d are 
coefficients supplied by the user.  

� c - Specifies the first coefficient in this function. 
� d - Specifies the second coefficient in this function. 

• Stream flow rate at point of entry - Specifies the flow rate of the 
stream (units may be specified in combo box). 
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The constituent parameters screen consists of entry forms for all of the 
constituent-specific parameters such as decay rates, partition coefficients, 
etc. The constituent parameters screen is shown in Figure 18, and an 
explanation of the input fields is given below.  

Figure 18. Constituent Parameters Screen.  
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Constituent Parameter Field Descriptions 

• Constituent - Constituents can be added, edited, or deleted using the 
button to the right of the usage constituent combo box. Use the drop-
down button at the right to select the appropriate action from the menu 
as shown in Figure 19. Then click on the button to perform the action. 

Figure 19. Constituent Drop-Down Button.  

• Constituent CAS ID - Specifies the Chemical Abstract Services 
identification number for the currently selected constituent. 

• Constituent background stream concentration at point of 
entry - Specifies the background concentration of the currently 
selected constituent in the stream (units may be specified in combo 
box). 

• Initial constituent concentration in sediment bed - Specifies 
the initial concentration of the currently selected constituent in the 
sediment bed (units may be specified in combo box). 
 
*Note - The following decay rates do not include physical losses such 
as volatilization, settling, burial, etc. They are a summation of 
degradation mechanisms such as biodegradation, hydrolysis, 
photolysis, etc. 
 

• Decay rate of dissolved phase in water column - Specifies the 
decay rate of the dissolved phase/fraction of the currently selected 
constituent in the water column (units may be specified in combo box). 

• Decay rate of particulate phase in water column - Specifies the 
decay rate of the particulate phase/fraction of the currently selected 
constituent in the water column (units may be specified in combo box). 

• Decay rate of dissolved phase in sediment bed - Specifies the 
decay rate of the dissolved phase/fraction of the currently selected 
constituent in the sediment bed (units may be specified in combo box). 

• Decay rate of particulate phase in sediment bed - Specifies the 
decay rate of the particulate phase/fraction of the currently selected 
constituent in the sediment bed (units may be specified in combo box). 
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• The user may enter either the octanol-water partition coefficient or 
partition coefficients in the water column and sediment bed: 
o Octanol-water partition coefficient - Specifies the octanol-

water partition coefficient for the currently selected constituent in 
units of mL octanol/mL water. The octanol–water partition coeffi-
cient, or KOW, is a measure of the preference of the constituent to 
bind to organic materials or to remain in the water column. If the 
KOW is specified, it will be used to calculate the partition coeffi-
cients in the water column and sediment bed. 

o Partition coefficient in water column - Specifies the partition 
coefficient of the currently selected constituent in the water column 
in units of L/kg. This value will be ignored if the KOW is specified 
above. 

o Partition coefficient in sediment bed - Specifies the partition 
coefficient of the currently selected constituent in the sediment bed 
in units of L/kg. This value will be ignored if the KOW is specified 
above. 

• Volatilization rate - Specifies the rate of volatilization of the cur-
rently selected constituent from the water column (units may be speci-
fied in combo box). Note*: only the dissolved fraction of the constitu-
ent will be considered in the volatilization calculations. Select the 
"Calculate" option to have this value automatically calculated by the 
model. 

• Mass transfer velocity - Specifies the mass transfer velocity of the 
currently selected constituent across the sediment–water interface 
(units may be specified in combo box). Note*: only the dissolved 
fraction of the constituent will be considered in mass transfer 
calculations. Select the "Calculate" option to have this value 
automatically calculated by the model. 

• Molecular Weight (g/g-mole) - Specifies the molecular weight of 
the selected constituent. This value is required if the "Calculate" option 
is specified for the volatilization rate. 

• Molecular Diffusivity - Specifies the molecular diffusivity of the 
selected constituent. This is required if the "Calculate" option is 
specified for the mass transfer velocity. 

• Henry's Law Constant (atm-m^3/g-mole) - Specifies the Henry's 
law constant for the selected constituent. This is required if the 
"Calculate" option is specified for the volatilization rate. 
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The sedimentation parameters screen consists of a grid for entering settl-
ing, burial, and resuspension velocity data at specified downstream loca-
tions. Since velocities can change along the stream reach, the model will 
accept velocity data at any distance along the reach. A value must be 
specified for the upstream boundary (downstream distance = zero). If no 
other velocity data are entered, these values will be used for the entire 
stream reach. When velocities are entered at multiple distances, the model 
will perform a linear interpolation to determine the value to use for each 
segment of the reach. If all velocity values are zero, the model will ignore 
the water column and sediment bed interactions. In this case the solids 
will not be modeled, and the constituents will only be modeled in the 
water column. The sedimentation parameters screen is shown in 
Figure 20, and an explanation of the input fields is given below.  

Figure 20. Sedimentation Parameters Screen.  
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Sedimentation Parameters Field Descriptions 

• Distance - Downstream distance where the velocities will be specified 
(units may be specified in combo box). Two of the three velocities must 
be specified at each distance, and the third should be set to zero to be 
calculated by the model. Velocities must be specified at the entry point, 
downstream distance of zero, and these values will be used for all 
calculations if no other distances are specified. 

• Settling Velocity - Specifies the settling velocity at the given distance 
(units may be specified in combo box). 

• Burial Velocity - Specifies the burial velocity at the given distance 
(units may be specified in combo box). 

• Resuspension Velocity - Specifies the resuspension velocity at the 
given distance (units may be specified in combo box). 

All of the grids in the CMS interface operate in the same manner. Data can 
be copied, cut, pasted, or deleted using shortcut keys or the context menu 
(Figure 21), which is available by clicking the right mouse button on the 
grid. The default number of rows in a grid is 100. Rows can be added to 
the bottom of a grid as necessary by using the "Insert Row(s)" option in 
the context menu. The shortcut keys for each of these actions can be seen 
in the context menu where appropriate.  
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Figure 21. Sedimentation Parameters Grid Context Menu.  

The CMS will also allow a steady-state solids concentration to be used. In 
this case, only one set of velocities is required at the upstream boundary 
and will be assumed constant along the entire reach. Solids will not be 
modeled in the water column and no constituent flux entries for solids will 
be allowed. The suspended solids concentration entered for the upstream 
boundary will be used as the steady-state concentration throughout the 
reach. When the model is being run with a steady-state solids balance in 
the water column, the sedimentation parameters screen will look as shown 
in Figure 22. The user will input two of the three velocities and the model 
will calculate the third. *Note - This is currently the only option available 
when the model is running under ARAMS/FRAMES. The solids transport 
code is currently under development and will be available in a later 
release.  
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Figure 22. Sedimentation Parameters Screen with Steady-State Solids Balance.  

 

The loading data screen consists of a grid for entering water flow, 
suspended solids concentration, and constituent fluxes for the upstream 
loads at specified time periods. The loading data screen and water flow 
input grid are shown in Figure 23, and an explanation of the input fields is 
given below.  
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Figure 23. Loading Data Screen (Water Flow Grid).  

 

Water Flow Field Descriptions 

• Time - Specifies a time period for which a water flow value will be 
specified (units may be specified in combo box). The water flow must 
be specified at the initial time, a value of zero, and this value will be 
used for all calculations if no other values are specified. 

• Water Flow - Specifies the water flow at the designated time (units 
may be specified in combo box). 
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Figure 24. Loading Data Screen (Suspended Solids Concentration Grid).  

 

Suspended Solids Concentration Field Descriptions 

• Time - Specifies a time period for which a suspended solids 
concentration value will be specified (units may be specified in 
combo box). The suspended solids concentration must be specified 
at the initial time, a value of zero, and this value will be used for all 
calculations if no other values are specified. 

• Concentration - Specifies the suspended solids concentration at 
the designated time (units may be specified in combo box). 

• *Note - if the model is being run with a steady-state solids balance, 
the suspended solids concentration grid will be disabled. In this 
case, the value entered on the model parameters screen will be used 
as the steady-state solids concentration.  
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Figure 25. Loading Data Screen (Constituent Flux Grid).  

 

Constituent Concentration Field Descriptions 

• Constituent loading type - Specifies if the constituent data will be 
entered using fluxes or concentrations. This applies to all constituents 
and will be the same for each of these. 

• Time - Specifies a time period for which a constituent flux value will 
be specified (units may be specified in combo box). The constituent 
flux must be specified at the initial time, a value of zero, and this value 
will be used for all calculations if no other values are specified. 

• Constituent Flux - Specifies the constituent flux at the designated 
time (units may be specified in combo box). 



ERDC/EL TR-07-1 47 

 

The model is run by selecting "Model -> Run" from the main menu or 
pressing the F5 key. When the model is executing, the main window of the 
program will be hidden. A new dialog will be displayed indicating the 
progress of the model, the current model time step, and the current 
simulation time during the execution (Figure 26). The model run can be 
terminated by clicking the "Cancel" button at any point during the 
execution process.  

Figure 26. Model Progress Dialog.  

The execution options dialog allows the user to specify the action that is to 
be taken when running the model with data that have been modified. If the 
current project has been modified and the changes have not been saved, 
the application can perform one of three tasks: 

• Automatically save on run - Specifies that the model will auto-
matically save any changes to the original file before running the 
model.  

• Save to temporary file on run - Specifies that the model will use a 
temporary file with all of the current project settings and leave the 
original file unmodified. This is useful to see what effect a certain 
change will have on the model results without modifying the original 
file.  

• Prompt user for action - Specifies that the model is to prompt the 
user for an action to take whenever the model is run and there are 
changes that have not been saved.  

The default setting is to use a temporary file if this situation arises, but the 
user can modify this by using the "Execution Options" dialog. The execu-
tion options dialog and all available options are shown in Figure 27.  
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Figure 27. Execution Options Dialog. 

Before the model is run, the program checks to ensure that all required 
data have been entered. This prevents errors from occurring during model 
execution and informs the user about the data that need to be entered. 
When a problem is found in the current data set, a dialog such as the one 
shown in Figure 28 will be displayed. The user should then proceed to 
correct the problem and try running the model again.  

In addition to the message given for input data errors, the input fields on 
each screen change colors to indicate if the data that have been entered are 
valid for the current parameter. This can be seen in Figure 28 above where 
the model time step input field is light red instead of the green color 
shown for other fields.  
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Figure 28. CMS Input Error.  

Once model execution has begun, errors may occur as a result of many 
factors such as an imbalance in the suspended solids, an error reading or 
writing to a data file, or even because the user presses the "Cancel" button. 
When an error occurs during model execution, a message dialog will be 
displayed that indicates what error occurred (Figure 29). The user can 
then take steps to correct the error and re-run the model.  
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Figure 29. Model Execution Error.  

If the error was caused by user intervention, pressing the "Cancel" button, 
the error message will appear as shown in Figure 30. No action is required 
by the user since the only error that occurred was an interruption in the 
model execution process.  
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Figure 30. User Intervention Error. 

After the model has been run successfully, the "Results" menu item under 
the "Model" menu will be enabled (Figure 31). This menu item is also 
enabled when loading an input file that has been run successfully and 
when loading a results data file. If the model was not run successfully, and 
no results file was created, the menu item will not be enabled. 

Figure 31. View Results Menu Item. 
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To view the model results, select "Model -> Results" from the main menu. 
The results form shown in Figure 32 will then be loaded. This form will 
allow the user to view the model results in a variety of ways, both text and 
graphical. Descriptions of the form fields and the functions they perform 
are listed below. Once all of the required information has been specified, 
click the "View Plot" button to load the plot dialog. 

Figure 32. Results Form 

 

Results Form Field Descriptions 

• Results Type - Specifies how the results will be displayed to the user. 
The two available options are Graphical and Text. The graphical option 
will display a plot with the user-specified information, and the text 
option will display the same user-specified information in a tabular 
view.  
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• Media Type - Specifies the values that are to be displayed. The two 
available options are Water and Sediment. The water option will 
display the values for the specified constituent in the water column. 
The sediment option will display the values for the specified 
constituent in the sediment bed.  

• Constituent - Specifies the constituent for which the model results 
will be displayed. This list contains all of the constituents specified in 
the model input and also contains a "Suspended Solids" entry when the 
media type is specified as "water." This allows the user to view the 
suspended solids concentration in the water column.  

• Title - Specifies a title that will be placed at the top of the plot that is 
produced. This is optional and is present mainly to allow for the option 
of having a title on images that are exported from the plot dialog.  

• X-Axis - Specifies the values for the x-axis on the plot. The two 
available options are Distance and Time. The distance option will plot 
concentration values on the y-axis versus downstream distance along 
the x-axis. The time option will plot concentration values on the y-axis 
versus time on the x-axis.  

• Y-Axis - Specifies the values for the y-axis on the plot. The only avail-
able option at the current time is Concentration. The concentration of 
the selected constituent will always be plotted on the y-axis.  

• Y-Axis Units - Specifies the units for the concentrations plotted on 
the y-axis. The units for the concentration in a water column plot will 
always be in units of mg/L. The units of the concentration in a sedi-
ment plot can be either mg/L or mg/kg dry weight. The default for a 
sediment plot is mg/kg.  

• Total/Dissolved - Specifies if the concentration will be the total 
concentration for the selected media or only the concentration that is 
in the dissolved phase. The dissolved phase concentration in the sedi-
ment bed refers to the concentration in the pore water. Therefore, the 
dissolved concentration can only be viewed in units of mg/L and refers 
to the mass dissolved in the pore water per volume of pore water.  

• Select Times (Select Distances) - The label for this input option 
will vary depending upon the value that is chosen for the x-axis. If the 
x-axis option is specified as "Distance," this list will allow the selection 
of times for which the concentration vs. distance plots are to be 
displayed. If the x-axis option is specified as "Time," this list will allow 
the selection of distances for which the concentration vs. time plots are 
to be displayed. The user may select a series of values from this list by 
selecting the first value and holding down the shift key while selecting 
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the last value. Multiple values may also be selected individually by 
holding down the control key while selecting the values. 

• Animate All - This option is used to animate the series of plots for 
concentration vs. time or concentration vs. distance. If this option is 
selected, the list box containing all of the values will be disabled since 
all values will be used in the animation.  

• Graph X Dimension/Graph Y Dimension - Specify the width and 
height of the plot that will be produced. The minimum plot size that 
can be produced is 400 × 300, and the maximum plot size that can be 
produced is 800 × 600. All values are in pixels. 

The plot dialog will appear as shown in Figure 33 for a single time or 
distance value. A plot for multiple distance values is shown in Figure 34. 

Figure 33. Plot Dialog for a Single Distance. 
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Figure 34. Plot Dialog for Multiple Distance Values. 

Time values on the x-axis are always in days and distance values on the x-
axis are always in meters. The label for the y-axis indicates the constituent 
for which the concentration is being plotted as well as the units that were 
selected. The concentration values always indicate total concentration 
(dissolved and particulate). 

There are buttons at the bottom of the dialog. The "Animate Graph" button 
is not enabled unless the "Animate All" selection was made on the results 
form. The "Save Graph" button is used to save the current plot to an image 
file. The "Print Graph" button is used to print out a hard copy of the 
current plot. The "Close Dialog" button will close the plot dialog and 
return the user to the results form. 

If the "Animate All" selection is made on the results form, the plot dialog 
will appear as shown below in Figure 35. 
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Figure 35. Plot Dialog in Animation Mode. 

The "Animate Graph" button is now enabled, and several additional 
controls appear on the dialog. When the animate button is clicked, the 
plots will be displayed in order for each time or distance value (depending 
upon which value was chosen for the x-axis) beginning with the first value. 
While the animation is playing, the caption of the "Animate Graph" button 
will change to display "Cancel." This button can be clicked during the 
animation to cancel playback. The box labeled "Animation Speed" is used 
to control the speed of the animation. The default value is "5" and ranges 
from a low value (slowest) of 1 to a high value (fastest) of 10. The slider 
control is used to move through the plots without actually playing the 
animation. The two buttons on the left side of the slider control, from left 
to right, are used to move to the first image in the animation or to the 
previous image in the animation. The two buttons on the right side of the 
slider control, from left to right, are used to move to the next image in the 
animation or to the last image in the animation. If the "Save Graph" 
button is clicked for an animation, the user has the option to save the 
current form of the animation or to save the entire animation as an MPEG 
file. The action that is taken is determined by the type of file chosen in the 
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save file dialog (Figure 36). If the *.mpg extension is chosen, the entire 
animation is saved. Otherwise, the current plot is saved. 

Figure 36. Save File Dialog. 

The text viewer displays the concentration data in a tabular format allow-
ing the user to view any point in the data series. When the "Text" option is 
chosen for the results type on the results form, many of the options 
available for graphical results are no longer available. This is because all of 
the data series will be displayed and there is no plot size to define. The 
results form will appear as shown in Figure 37. 
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Figure 37. Results Form for Text Results. 

The user may select the media type, constituent, and units for the y-axis as 
was done for the graphical results. The "View Data" button is then used to 
open the text viewer form (Figure 38). This form displays the downstream 
distance in meters in the column header (top row) and the time in days in 
the first column. The user can scroll to any point to view data values. The 
data can be printed using the "Print Data" button or exported to a comma-
separated file using the "Save Data" button. 

Figure 38. Text Viewer. 
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References can be useful to indicate where or how a certain value in the 
model input was obtained. References can be added for most fields in the 
model, and the reference number will be shown to the right of the field as 
in Figure 39 below for the Octanol–Water Partition Coefficient. 

Figure 39. Reference Number Indicator. 

To view all references used in the current project, select "References -> 
View" from the main menu (Figure 40). 

Figure 40. References Menu. 
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The references dialog will then be displayed as shown in Figure 41. The 
user can click on the column labels to sort the references in either ascend-
ing or descending order according to any of the columns. This dialog is 
also used to delete references. To delete a reference, select the appropriate 
reference in the list and click the "Delete Reference" button at the bottom 
left corner of the dialog. If multiple fields are using a reference, it will be 
displayed once for each field with the field name and constituent name 
(where applicable) listed in the appropriate columns. A reference cannot 
be deleted if one or more fields are currently using it. Therefore, a 
reference can be deleted only if the "Field Name" column is empty. 

Figure 41. CMS References. 

To enter a new reference or edit an existing reference for a field in the 
current project, make sure that the desired field is selected and choose 
"References -> Add/Edit" from the main menu. The reference dialog 
(Figure 42) will then appear as shown below. 
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Figure 42. Reference Dialog. 

The reference number is automatically generated and can not be modified. 
An existing reference can be used for the current field by clicking the 
"Select" button. The dialog shown in Figure 43 will be displayed, allowing 
the user to select from the list of existing references. 
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Figure 43. Reference Selection Dialog. 

To remove the reference from the current field, click the "Unlink Field" 
button at the bottom left corner of the reference dialog shown in Figure 
42. This will remove the reference number from the field but will not 
delete the reference information so that it may be used with other fields. 

CMS numerical solution options and settings can be modified through the 
"Options" menu (Figure 44). Through these menu options, users can 
modify numerical solution scheme settings, solids balance type, and print 
interval/frequency settings. 

Figure 44. Tools Menu. 

The default numerical solution settings dialog allows the user to modify 
the numerical solution scheme and solids balance settings. These settings 
will be used for all new projects and all existing projects that have not 
overridden the default settings. The default numerical solution settings 
dialog is shown in Figure 45, and the field descriptions are given below. 
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Figure 45. Default Numerical Solution Settings Dialog. 

 

Default Numerical Solution Settings Field Descriptions 

• Use adaptive method for sediment calculations - Specifies that 
the model should use an adaptive method for performing the sediment 
bed calculations. This will allow the model to modify the time step in 
order to maintain the stability of the calculations. This will apply to 
both the first-order Euler and fourth-order Runge-Kutta schemes.  

• Use Runge-Cutta scheme sediment calculations - Specifies that 
the model should use the fourth-order Runge-Kutta scheme for the 
sediment calculations instead of the default first-order Euler scheme.  

• Coefficient of implicity for advective term - Specifies the 
division of the advection numerical solution scheme into explicit and 
implicit parameters. A value of "0" specifies a fully explicit scheme and 
uses only values from the current time step. A value of "1" specifies a 
fully implicit scheme and uses only values from the future time step.  

• Coefficient of implicity for diffusive term - Specifies the division 
of the diffusion numerical solution scheme into explicit and implicit 
parameters. A value of "0" specifies a fully explicit scheme and uses 
only values from the current time step. A value of "1" specifies a fully 
implicit scheme and uses only values from the future time step.  
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• Scheme to use for advective term - Specifies the numerical 
solution scheme to use for the solution of the advective terms. The 
diffusive terms are always solved using the second-order accurate 
Crank-Nicolson centered-time, centered-space method. The advective 
terms can be solved using either the Crank–Nicolson method or the 
first-order accurate upwind method. The upwind method is not as 
sensitive to large changes in the concentration gradient, but it induces 
numerical diffusion.  

• Solids balance type - Specifies if the suspended solids in the water 
column are assumed to be at steady-state or if the solids should be 
modeled in the same manner as the constituents. The steady-state 
option will use the value entered for the total solids concentration at 
the point of entry as the steady-state concentration. The unsteady-state 
option combines this value with the values entered on the loading data 
screen to model the solids concentration along the stream reach. 
*Note - The only option currently available while the model is running 
under ARAMS/FRAMES is the steady-state solids balance. The solids 
transport code is under development and will be available in a later 
release. 

The project numerical solution settings dialog allows the user to modify 
the numerical solution scheme settings, the solids balance type, and the 
print interval for the current project. These settings will be used only for 
the current project and can be reset to use the default system settings at 
any point by clicking the button labeled "Reset to System." The project 
numerical solution settings dialog is shown in Figure 46, and the field 
descriptions are listed below. 
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Figure 46. Project Numerical Solution Settings Dialog. 

 

Project Numerical Solution Settings Field Descriptions 

• Print interval - Specifies how frequently data will be written to the 
output file when running the model. This value is specified in a similar 
fashion as the time step. By default, the "Same as time step" option is 
selected. This will print a data point for every time step. If this option is 
not selected, the data will be output only on the print interval specified 
here. *Note - this does not apply when the adaptive method is selected. 
The adaptive method will modify the time step as necessary and may 
not be able to output data at the exact times specified. In this case, the 
model will attempt to output data at the time step interval originally 
specified by the user on the Model Parameters screen.  

• Use adaptive method for sediment calculations - Specifies that 
the model should use an adaptive method for performing the sediment 
bed calculations. This will allow the model to modify the time step in 
order to maintain the stability of the calculations. This will apply to 
both the first-order Euler and fourth-order Runge-Kutta schemes.  
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• Use Runge-Kutta scheme sediment calculations - Specifies that 
the model should use the fourth-order Runge-Kutta scheme for the 
sediment calculations instead of the default first-order Euler scheme.  

• Coefficient of implicity for advective term - Specifies the divi-
sion of the advection numerical solution scheme into explicit and 
implicit parameters. A value of "0" specifies a fully explicit scheme and 
uses only values from the current time step. A value of "1" specifies a 
fully implicit scheme and uses only values from the future time step.  

• Coefficient of implicity for diffusive term - Specifies the division 
of the diffusion numerical solution scheme into explicit and implicit 
parameters. A value of "0" specifies a fully explicit scheme and uses 
only values from the current time step. A value of "1" specifies a fully 
implicit scheme and uses only values from the future time step.  

• Scheme to use for advective term - Specifies the numerical solu-
tion scheme to use for the solution of the advective terms. The diffusive 
terms are always solved using the second-order accurate Crank–
Nicolson centered-time, centered-space method. The advective terms 
can be solved using either the Crank–Nicolson method or the first-
order accurate upwind method. The upwind method is not as sensitive 
to large changes in the concentration gradient, but it induces numerical 
diffusion.  

• Solids balance type - Specifies if the suspended solids in the water 
column are assumed to be at steady-state or if the solids should be 
modeled in the same manner as the constituents. The steady-state 
option will use the value entered for the total solids concentration at 
the point of entry as the steady-state concentration. The unsteady-state 
option combines this value with the values entered on the loading data 
screen to model the solids concentration along the stream reach. 
*Note - The only option currently available while the model is running 
under ARAMS/FRAMES is the steady-state solids balance. The solids 
transport code is under development and will be available in a later 
release. 

The Help menu provides access to information concerning the CMS 
model. Selecting "Contents" from the help menu or pressing the "F1" key 
will display this help file. The initial location displayed in the help file will 
depend upon the current data screen and field that are selected. This 
allows for help to be displayed for a specific data field simply by clicking 
into the field and pressing the "F1" key. The Help menu is shown in 
Figure 47. 
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Figure 47. Help Menu. 

The "About" item in the Help menu will display an informational dialog 
containing a brief description of the model, the current version number, 
and a link to a Web site with more information pertaining to the Stream 
Model. The About dialog is shown in Figure 48. 

Figure 48. About Dialog. 
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Appendix A:  Calculation of Volatilization 
Rate 

A modified version of the two-film theory (Chapra 1997) is used to calcu-
late volatilization. Figure A-1 depicts the air–water interface and the two 
laminar films on either side of the interface.  

Figure A-1. Representation of Whitman’s two-film theory of gas transfer. 

The two-film theory implies that the two laminar layers act as a series of 
resistors for the transfer of gas between the liquid and air. The limiting 
factor for the transfer rate is the film with the highest resistance or, in 
turn, the lowest transfer velocity. The equation for the two-film theory is 
given in Equation A-1. 

 1 1 a

v l e g

RT
V K H K
= +  (A-1) 

where 

 Vv = net transfer velocity across the air–water interface, m/day  
 Kl = bass transfer velocity in the liquid laminar layer, m/day 
 R = ideal Gas constant, 8.206E-5 m3 atm (mol K)–1 
 Ta = absolute temperature, K 
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 He = Henry’s law constant, atm m3 mol–1 
 Kg = mass transfer velocity in the gaseous laminar layer, m/day. 

The liquid mass transfer velocity is calculated using the following formula 
(Mills et al. 1985) that relates the mass transfer velocity of oxygen to the 
current constituent using the ratio of the molecular weights. 

 
2

0.25

,
32

l l OK K
M

⎛ ⎞⎟⎜= ⎟⎜ ⎟⎜⎝ ⎠  (A-2) 

where 

 
2,l OK  = mass transfer velocity of oxygen in the liquid laminar layer, 

m/s 
 M = molecular weight of the constituent, g/mol. 

The mass transfer velocity of oxygen is determined using two formulas; 
the first relates the transfer velocity to the wind speed above the surface of 
the water (Equation A-3) (Banks 1975, Banks and Herrera 1977), and the 
other relates the transfer velocity to the stream velocity (Equation A-4) 

(O’Connor and Dobbins 1958). 

 
2

0.5 2
, 0.728 0.317 0.0372l O w w wK U U U= − +  (A-3) 

 
2

0.5

, 3.95 w
l O

UK
H

⎛ ⎞⎟⎜= ⎟⎜ ⎟⎜⎝ ⎠  (A-4) 

where 

 Uw = wind speed at 10m above the surface of the water, m/s 
 H = depth of the stream, m. 

The largest value of the oxygen mass transfer velocity calculated with 
Equations A-3 and A-4 is then used in equation A-2 since this would 
represent the highest possible transfer rate. The gas mass transfer velocity 
is calculated using another formula from Mills et al. (1985), which is simi-
lar to Equation A-2 for the liquid transfer velocity. This equation relates 
the transfer velocity of the constituent in the gaseous phase to that of 
water vapor. 
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M

⎛ ⎞⎟⎜= ⎟⎜ ⎟⎜⎝ ⎠  (A-5) 

where 

 
2,g H OK  = mass transfer velocity of water vapor in the gaseous laminar 

layer, m/s. 

The mass transfer velocity for water vapor is determined as a function of 
wind speed using the following equation (Mills et al. 1985). 

 
2, 168g H O wK U=  (A-6) 

As can be seen from the equations above, there is no volatilization in the 
absence of wind with the two-film theory. However, this is not always the 
case for swift streams and highly volatile constituents. Therefore, the 
minimum value for the gas transfer coefficient, Kg, of 100 m/day will be 
set to prevent limiting the volatilization rate under these circumstances. 
This is also the approach used in both WASP (Wool et al. 2001) and 
ICM/TOXI (Wang et al. in press) for fast-moving streams. 
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Appendix B:  Calculation of Mass Transfer 
Rate for Sediment—Water Interface 

It is assumed that the mass transfer across the sediment–water interface 
acts in a similar manner to the two-film model for volatilization calcula-
tions. A two-layer model does not exist for diffusion between the sediment 
pore water and the water column, but the transfer rate can be calculated 
based on the properties on each side of the boundary and will be limited by 
the lowest transfer velocity. The transfer rate can be limited by a low 
diffusion rate or flow rate in the water column or by a low diffusion rate in 
the sediments. To capture the influence of each of these factors, the mass 
transfer velocity will be calculated using formulations derived by Schink 
and Guinasso (1977) and Di Toro et al. (1981). 

The formula given by Schink and Guinasso (1977) is shown below in 
Equation B-1 and provides a rate based on water column properties such 
as the molecular diffusivity of the constituent in water, the viscosity of the 
water, and the flow shear velocity along the bed. 

 

2
3

*

24

m

d

Du
vV

⎛ ⎞⎟⎜ ⎟⎜ ⎟⎜⎝ ⎠=  (B-1) 

where 

 Vd = mass transfer velocity, cm/day 
 *u  = flow shear velocity along the bed, which is approximately 10 

percent of the mean velocity of flow, m/s 
 Dm = molecular diffusivity of dissolved chemical, m2/s 
 v = kinematic viscosity of water at temperature T, m2/s. 

The kinematic viscosity of water can be calculated for a given temperature, 
T, using the following formula. 

 
6

2

1.79 10
1.0 0.03368 0.000221

x
v

T T

−

=
+ +

 (B-2) 
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where 

 T = temperature, °C. 

In the equation given by Di Toro et al. (1981), the mass transfer is esti-
mated as a function of the molecular weight of the constituent and the 
porosity of the bed sediments as shown in equation B-3 below. 

 ( )
2
319dV M −= φ  (B-3) 

where 

 Vd = mass transfer velocity, cm/day 

 φ = porosity of the bed sediments 
 M = molecular weight of the constituent, g/mol. 

After calculation of the mass transfer velocity with each of these methods, 
the smaller of the two values will then be used for the mass transfer 
velocity since this will be the limiting rate. 
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